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Copyright 
Copyright TimeValue Software, Inc. (a California Corporation) 1987-2008.  
All rights reserved. When you purchase a copy of TaxInterest, you are 
authorized to use it on a single machine.  You may make backup copies for 
your own use only.  TimeValue Software licenses TaxInterest on a per seat 
basis.  This means that each user must pay for a TaxInterest license.  Please 
respect the rights of TimeValue Software and refrain from distributing copies 
of this software.  Such practices are in violation of copyright laws. 

Please contact us regarding multiple-user/network or site-license 
arrangements. 

 TimeValue Software Phone: (800) 426-4741 
 22 Mauchly Phone: (949) 727-1800 
 Irvine, CA 92618 Fax: (949) 727-3268 
  www.timevalue.com 
  Email: info@timevalue.com 

Guarantee 
If you are unsatisfied with TaxInterest for any reason, you may return it 
within one year of purchase.  We will promptly refund your purchase price. 

Disclaimer 
TaxInterest is intended as an aid to tax professionals.  As with any software 
tool, it is up to you to use it appropriately.  It can produce results at variance 
with legal, contract, or trade practice requirements.  The computations, like 
those of any assistant, should be reviewed with due professional care.  The 
program does not cover all possible cases, and may not include recent 
developments. 
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Welcome to TaxInterest 
 

The TaxInterest program will help you calculate interest on tax for the IRS 
and other tax jurisdictions.  TaxInterest also calculates federal penalties and 
interest on penalties.  In addition, TaxInterest prepares comprehensive reports 
that document how the computation is performed. 

How to use this User’s Guide 
Refer to the Getting Started section to get the software up and running. 

Work through the TaxInterest Tour section.  This example will give you a 
hands-on tour of the software. 

Refer to the remaining sections for further information on TaxInterest’s 
features and usage. 

The Penalty Basics section is a good reference tool regarding the IRS rules 
for calculating common penalties. 

While this user’s guide is an important reference tool, TaxInterest also 
contains a comprehensive Help system.  The built-in help system should be 
your first step in finding answers to your questions.  To reach the help 
system, select a topic from the Help menu, or press F1. 

Customer Support and Maintenance  
Our knowledgeable staff can help you get the most from TaxInterest.  We 
encourage both new and experienced users alike to contact us for any help 
you might need. 

Contact Customer Support at (800) 426-4741 or (949) 727-1800 Monday 
through Friday from 7:00am to 6:00pm Pacific Time.  Contact us via email at 
support@timevalue.com or by fax at (949) 727-3268. 

TaxInterest Update Service  
Your first year of TaxInterest updates is included with your purchase.  This 
service keeps your software up to date so it is ready when you need it most.  
You will automatically receive three quarterly (March, June, September, 
December) updates in addition to your initial purchase at no additional 
charge.  The TaxInterest Update Service also includes upgrades, unlimited 
technical support, replacement CDs, and additional user’s guides as needed. 

The TaxInterest Update Service is renewable annually beginning one year 
after your initial purchase.  
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Getting Started 
 

System Requirements 
TaxInterest requires a computer running Windows Vista, XP, 2000, NT, 98, 
or later.  To run in a satisfactory manner, TaxInterest requires at least 4MB of 
RAM and 1GB of available disk space. 

Installing TaxInterest 
The TaxInterest program files may be shipped on a CD or downloaded in 
compressed form.  In order to run TaxInterest, the program must be installed 
on your computer or server.  If you experience any difficulty installing 
TaxInterest, contact our Support Team at (800) 426-4741 or 
support@timevalue.com. 

To install the single user edition of TaxInterest 

1. Insert the TaxInterest CD or double click on the downloaded installation 
file.  After a few moments, the TaxInterest installation screen will appear.  
Follow the on-screen instructions. 

The TaxInterest installation will default to C:\TAXINT.  You can change the 
destination drive to install to a different drive if needed.  All the TaxInterest 
program files will be copied into this directory.  A Windows program group 
will be created and a TaxInterest shortcut will be placed on your Windows 
desktop. 

The single user edition of TaxInterest is intended for installation on a single 
computer.  See our Copyright notice on page ii for details.   

If you are installing the network edition of TaxInterest, be sure to install the 
program to your network drive and refer to the guidelines on the following 
page. 

Note  When you install TaxInterest, we recommend installing it to the 
default directory.  If an earlier version of TaxInterest already exists on your 
computer, install the new version in the same directory.  Installing new 
versions over old will not affect your saved data files.  This will ensure all 
users are running the latest version without updating shortcuts. 
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Getting Started 
 

TaxInterest on a Network 
The multi-user/network edition of TaxInterest is designed to operate 
efficiently on your network.  It supports multiple users running the same 
program from the same directory and individual setup files for each user.  
After installing TaxInterest on your network drive, please refer to the 
following steps to create an icon for each user/workstation. 

To setup network workstations for TaxInterest 

(Perform the following setup from each workstation after you install the 
software on your network server.) 

1. Navigate to the directory where you installed TaxInterest (e.g., 
F:\TAXINT). 

2. Double-click on WorkstationSetup.exe from the TaxInterest program 
directory. 

3. Follow the on-screen instructions.  This routine will add desktop 
shortcuts and required reporting files to the workstation. 

Installing Quarterly Updates 
Current TaxInterest subscribers will receive quarterly TaxInterest updates via 
CD or via download.  If you have not installed all updates consecutively, you 
need only install the latest update to bring your software completely up to 
date. 

Be sure to install the updates in the same directory as your current version.  
For network installations, you only need to install the update on the server.  
You do not need to update the individual workstations. 

3 



Getting Started 
 

4 

  



 

TAXINTEREST TOUR 
 
 

Starting TaxInterest  6 
Entering Information to Calculate Interest and Penalties  6 
Calculating the Interest and Penalty Totals  10 
Displaying Reports  11 
Printing Reports  11 
Saving and Retrieving Your Work  11 
Exiting TaxInterest  12 

 

5 



TaxInterest Tour 
 

This chapter is designed to quickly familiarize you with the features of 
TaxInterest.  Along the way, you’ll learn the basics of calculating interest and 
penalties so you can get started right away.  Once you understand the basics, 
it’s easy to become proficient.  The ideas and procedures mentioned here are 
described in greater detail in subsequent chapters of the user’s guide. 

Starting TaxInterest 
1. Double-click the TaxInterest icon on your desktop.  If the TaxInterest 

shortcut does not appear on your desktop, click the Windows Start button 
and select Programs.  Select the TaxInterest program group and then 
choose the TaxInterest program icon. 

Entering Information to Calculate Interest and Penalties 
Facts  Michael O’Hare did not file his 2005 individual income tax return but 
he did get an extension of time to file the return until October 15, 2006.  He 
did not get an extension of time to pay.  The total tax on the return was 
$10,000.  O’Hare paid $3,000 through withholdings and also made a $1,500 
payment on March 11, 2007.  He expects to file his return and settle with the 
IRS on August 1, 2008.  O’Hare wants to calculate interest and penalties as 
of August 1, 2008. 

Selecting an interest rate table 

1. TaxInterest stores interest rates in individual rate tables.  The rate tables 
are updated quarterly for current TaxInterest subscribers.  When you start 
TaxInterest, it will default to the IRS interest rates, but state interest rate 
tables are also available.  To select an alternative table, click the Tables 
button on the toolbar.  For this example, we will use the IRS interest rates 
which are contained in the Federal.TB3 table.  

Entering the name and ID 

2. While the program does not require name or ID information, you may 
want this information on reports.  Click in the Name field and type 
Michael O’Hare.  Press Tab to move to the ID field. 

3. Type 555-55-5555 in the ID field.  Press Tab to move the cursor to the 
first event line. 

6 



TaxInterest Tour 
 

Entering tax and payment information 

4. The first event line will display a Tax event.  Events include Tax, 
Payment, Deposit as bond, Suspend interest, Resume interest, IRS 
Check, Entered penalty, and Motivated tax.  See pages 16-18 for a 
description of each event.  Press Tab to select the Tax event and move to 
the Date field. 

5. At the Date field, type 041506 and press Tab. 

 TaxInterest will display 04/15/06 when you move to the next field.  You 
can also input dates with separators between characters such as 04/15/06 
or 04-15-06.  The year can also be entered as four digits. 

6. In the Amount field, type 7000 and press Tab. 

The tax amount of $7,000 is the “net tax due” on April 15, 2006 after 
subtracting the $3,000 withholding from the $10,000 total tax amount.  If 
needed, you could enter the total tax amount and enter any withholding 
or payments as separate events.  Any payment prior to the tax due date 
should be dated as of the tax due date.  TaxInterest will offset the amount 
for you.   

7. In the Description field, type 2005 Net Tax Due and press Tab.  This 
description is optional and allows you to enter a description of the event 
that will appear on reports. 

 

The event on the second event line will default as a Payment.  Press Tab 
to move to the Date field. 

8. Type 031107 in the Date field and press Tab. 

9. Enter 1500 as the payment amount. 
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TaxInterest Tour 
 

Your screen should now appear as shown below. 

 

(At this point, you can enter additional payments, but this case involves 
only one payment.) 

Activating the Failure to File penalty 

10. Click the Penalties button on the toolbar to display the window below. 

 

11. Select the Failure to file return when due 6651(a)(1) penalty.  The 
Failure to File dialog will appear. 

12. To activate the penalty, click the check box entitled Activate the penalty 
for failure to file (if not already selected). 
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TaxInterest Tour 
 

13. At the Date return received by IRS field, type 080108.  To reflect the fact 
that O’Hare had an extension of time to file until October 15, change the 
Due date from 04-15-06 to 10-15-06.  After you’ve entered the 
information, the Failure to File window should look like this: 

 

14. Click OK to return to the Penalty Selection Window.  

Activating the Failure to Pay penalty 

15. In the Penalty Selection Window, select the Failure to pay tax shown 
on return §6651(a)(2) penalty.  The following window will appear: 

 

16. Click the check box to Activate the failure to pay penalty (if not 
already selected).  Since O’Hare did not receive a notice to pay the 
penalty, a notice of intent to levy, or a jeopardy demand, you do not need 
to enter any additional information.  Click OK to return to the Penalty 
Selection Window. 

17. Click Close to exit the Penalty Selection Window.   
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 When you return to the main screen, you will see that the bottom of the 
screen shows that the Failure to Pay and Failure to File penalties are 
active.  You can go directly to the penalty window by clicking on the 
penalty link. 

Calculating the Interest and Penalty Totals 
18. To compute interest and penalties, click the Compute button on the 

toolbar and the Compute Results window will appear. 

TaxInterest will use the current date as the interest computation date. 

19. In order to compute to August 1, 2008, change the compute date to        
080108 and click Recompute.  As you can see below, the total amount 
due on August 1, 2008, is $9,302.83. 
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Displaying Reports 
While viewing the compute results, click the Report button in the Compute 
Results window to see details on the interest and penalty computation. 

TaxInterest automatically shows the most commonly used report, the Interest 
and Penalty Detail Report.  To exit a report window and go back to the 
TaxInterest input screen, click the X in the top right corner of the report 
window or choose Exit from the File menu. 

In addition to this report, the program also has a number of other reports.  To 
see any of these reports, click the Reports button on the toolbar.   

Printing Reports 
When the Interest and Penalty Detail Report is displayed on the screen, the 
report can be printed by choosing Print from the File menu. 

If the report is not currently on the screen, you can print reports by clicking 
the Print button on the toolbar or choosing Print from the File menu and 
selecting the desired report from the window. 

Saving and Retrieving your Work 

Saving a TaxInterest file 

1. Click the Save button on the toolbar or choose Save from the File menu. 

2. Enter a name for the file and click Save.  TaxInterest will automatically 
add the .TX3 extension. 

Opening a TaxInterest file 

1. Click the Open button on the toolbar or choose Open from the File menu 
to display previously saved files. 

2. Double-click the file name you wish to open.   
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Deleting a TaxInterest file 

1. Click the Open button on the toolbar or choose Open from the File menu 
to display previously saved files. 

2. Right-click on the file you wish to delete and select Delete from the 
drop-down menu.   

Exiting TaxInterest 
To exit the program, choose Exit from the File menu. 
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TaxInterest Basics 
 

Main Screen 
With TaxInterest, you enter information on the main screen shown below.  
Generally, the information you enter on the main screen consists of the date 
and amount of any tax due and the date and amount of any payments made. 
The following is an example of the information you can enter on the main 
screen:  

 

Interest Rate Tables 
The interest rates and methods used by taxing authorities change from time to 
time.  For example, the Federal rates change quarterly and many states and 
jurisdictions follow suit.  TaxInterest keeps the information needed to make 
these calculations in separate files called rate tables.  Rate tables contain 
interest rates, the dates these rates are in effect, the year length, and the 
appropriate interest computation method.   

When you start TaxInterest, the program automatically defaults to the Federal 
IRS interest rates table called Federal.TB3.  To select a different table, click 
on the Tables button on the toolbar or choose Select Rate Table from the 
File menu to display a directory of available interest rate tables.  State rate 
tables are generally represented by the two letter state abbreviation.  Double-
click a table name in the list or select a table and click OK.  The active table 
name will appear in the Table field on the main screen. 
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TaxInterest Basics 
 

Interest Rate Updates 
TimeValue Software keeps the interest rates in your TaxInterest software 
updated for you.  As long as your subscription to TaxInterest is current, you 
will receive the updates on a quarterly basis on CD or via download.  Keep 
your TaxInterest Update Service current to be sure your software is updated 
for current tax rules and interest rates.  If you are not receiving quarterly 
TaxInterest updates, call us at (800) 426-4741 or email 
support@timevalue.com. 

If you find a need to update or modify the interest rates yourself or create a 
rate table for a jurisdiction not provided by TimeValue Software, you can 
choose Edit Interest Rate Table from the Options menu. 

Name and ID Fields 

Name 
This optional field lets you enter the taxpayer name.  This name will be 
printed at the top of all reports. 

 

ID 
This optional field lets you enter the taxpayer identification number.  This 
information will be printed along with the name at the top of all reports. 
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TaxInterest Events 
TaxInterest computes interest and penalties based on the series of events you 
enter on the main screen.  To select an event, move the cursor to the Event 
field.  Click on the Event field to display a list of TaxInterest events.  The 
available events are described below. 

 

Tax 
The Tax event is the most common TaxInterest event.  A Tax event is used to 
calculate deficiency interest on most underpayments.   

Payment (Refund) 
Use the Payment event to reflect a payment made by the taxpayer.  You can 
also use the Payment event to perform a refund calculation.  If the taxpayer is 
in a refund status (the amount of payments exceed the tax, interest, and 
penalties), TaxInterest automatically computes interest at the refund rate. 

Deposit as Bond 
In general, interest on unpaid taxes continues to accrue during the period that 
a taxpayer and the IRS dispute a tax liability.  A deposit in the nature of a 
cash bond stops interest from running on such underpayments much like a 
payment and may subsequently be used to pay the disputed liability. 

If the deposit exceeds the amount ultimately determined to be due, refund 
interest will accrue on the deposit as long as it is attributable to the tax.  The 
interest rate is the Federal short-term rate, compounded daily.  The taxpayer 
may request the return of all or part of the deposit – plus interest for the 
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period during which the IRS held the deposit – prior to the final 
determination.  If a liability is subsequently assessed, interest on the 
deficiency will be computed without regard to the period during which the 
IRS held the deposit.  See, Section 6603 and Rev. Proc. 2005-18 

Under prior tax law, Rev. Proc. 84-10 provided the procedures for taxpayers 
to make deposits in the nature of a cash bond to suspend the running of 
interest on tax deficiencies.  However, no refund interest was allowed if the 
deposit exceeded the tax. 

The Deposit as bond event in TaxInterest functions to stop interest from 
accruing on the corresponding amount of tax.  The amount of a deposit in 
excess of any tax will not accrue interest.  We recommended that you enter 
any excess amount as a Payment event in order to calculate the applicable 
interest.  Please contact our support team at 800-426-4741 for assistance on 
working with deposits as bonds. 

Suspend Interest 
The Suspend interest event stops the running of interest until you enter a 
Resume interest event.  The suspension applies to all interest computations. 
Interest can be suspended for a number of reasons.  For example, if a waiver 
of restrictions on the assessment of a deficiency has been filed and if notice 
and demand by the IRS is not made within 30 days, interest is suspended 
from that point until notice and demand is made. §6601(c). 

Resume Interest 
The Resume interest event re-starts interest after it has been suspended by the 
Suspend interest event. 

IRS Check 
An IRS Check event is used to reflect a cash flow from the IRS to the 
taxpayer.  If the amount of an IRS check exceeds the amount due to the 
taxpayer, the IRS Check event is treated like a tax and underpayment interest 
is computed on the excess of the amount due to the taxpayer.  This event also 
appears in the C Corp Refund window.  In the C Corp Refund window, you 
can allocate the amount of the check that reduces the high rate or GATT rate 
portion of a C corporation refund. 
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Entered Penalty 
The Entered penalty event allows you to enter a penalty amount that will be 
subject to interest at the underpayment rate.  Interest starts running as of the 
date entered on the main screen.  The interest computation for this amount 
will be kept separate from the interest computation for tax amounts.  Use the 
Entered penalty event to compute interest on penalties for state calculations 
or other jurisdictions where the penalty is not automatically computed by 
TaxInterest. 

Motivated Tax 
Prior to 1990, a deficiency resulting from substantial underpayment of tax 
attributable to a tax-motivated transaction is subject to an interest rate that is 
120% of the normal rate.  A substantial underpayment is defined as an 
underpayment of more than $1,000 for the year. 

The Motivated tax rules have been repealed, however, the Motivated tax 
rules continue to apply to deficiencies arising from returns due (without 
regard to extensions) prior to 1990.   

Customizing Event Names 
You may change the name of a Tax event to a custom name (i.e., “2007 audit 
adjustment”).  To use a custom name, enter the name in the Description 
column on the main screen.  When you print or view reports, the custom 
name will be displayed. 

If you want to use the Description field for notes and you do not want the text 
to display in reports, choose Report Setup from the File menu and select 
“Event name” instead of “Descriptions.”  
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IRS Penalties 
TaxInterest will calculate the most common IRS penalties.  These penalties 
can be selected individually or in combination.  To activate a penalty, click 
on the Penalties button on the toolbar or select Penalty Selection from the 
Compute Menu. 

Since the penalty rules may change from year to year, the content of the 
penalty selection menu and the penalty computations will change depending 
on the date of the tax event on the main screen.  As a result, TaxInterest 
cannot compute penalties for multiple years.  If you have penalties for 
more than one year, create separate TaxInterest schedules for each year.  If 
you know the penalty amounts, use the Entered penalty event. 

The following penalties are computed by TaxInterest: 

• Failure to file return when due  §6651(a)(1) 
• Failure to pay tax shown on return  §6651(a)(2) 
• Failure to pay amount assessed  §6651(a)(3) 
• Negligence  §6662(c) 
• Substantial understatement of income tax  §6662(d) 
• Substantial valuation misstatement  §6662(e) 
• Substantial overstatement of pension liabilities  §6662(f) 
• Substantial estate or gift tax valuation understatement  §6662(g) 
• Fraud  §6663 

IRC §6656 Failure to make deposit of taxes 

TaxInterest will not automatically compute the §6656 failure to deposit 
penalty.   This penalty requires information such as deposit due dates, actual 
deposit dates, taxpayer status, and other items.  TimeValue Software has 
software to address these needs.  Tax941 automatically calculates the late 
deposit penalty and prints required tax forms.  PayrollPenalty uses taxpayer 
relief to reallocate deposits within a period and calculate a lower penalty for 
the taxpayer.  For more information about Tax941 and PayrollPenalty, call 
TimeValue Software at (800) 426-4741 or visit www.timevalue.com. 

Interest on Underpayments 
Internal Revenue Code §6601(a) sets forth the basic rules relating to interest 
on underpayments.  As a general rule, interest is due from the date the tax is 
due to the date the tax is paid.  The rate of interest is determined under §6621 
of the code. 
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“Hot” Interest 
Starting in 1991, certain large corporate underpayments are subject to a 
higher rate.  This so-called “Hot” interest rate is applicable to underpayments 
in excess of $100,000 after a specifically defined “applicable date.”  The 
“Hot” interest rate is two percentage points over the normal rate. 

In order to invoke the higher “Hot” interest rate, click the Hot Interest 
button on the toolbar, or choose Hot Interest from the Compute menu.  A 
window will appear where you can provide the required applicable date.   

Motivated Tax 
For returns due before 1990, a higher interest rate is applied to substantial 
underpayments attributable to “tax motivated transactions.”  To invoke this 
higher rate, you must enter the tax due as a Motivated Tax.  You can select 
Motivated Tax in the Event field. 

Note  The Motivated tax rules have been repealed, but not retroactively.  The 
higher rate continues to apply to returns that were due before 1990. 

Saturday, Sunday, Holiday Rule 
If the due date for a return is Saturday, Sunday, or legal holiday, the payment 
will be on time if you make it on the next day that is not a Saturday, Sunday, 
or legal holiday.  In this case, no interest will be charged.  If a payment is not 
made on the next available business day, then interest will accrue from the 
original due date of the return.   See, Rev. Rul. 74-235, 1974-1 CB 347. 

Interest on Penalties 
Interest on penalties is computed using the same rates applicable to tax 
deficiencies. As a general rule, interest on the failure to file penalty and on 
accuracy-related penalties runs from the return due date, with extensions.  
For most other penalties, interest does not start until the IRS a notice. 

When the IRS sends a notice, taxpayers generally have a grace period within 
which they can pay without the accrual of additional interest.  The grace 
period is usually 21 days, but is only 10 days for notices demanding payment 
for $100,000 or more.  In addition, the grace period is 10 days for notices 
issued before 1997.  For more information, see §6601(e). 
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Interest on Refunds  
Refund interest is subject to special rules.  In order for TaxInterest to 
compute refund interest, you must identify the amount as a refund.  Note that 
certain interest-free periods may make it difficult to exactly match IRS 
interest computations. 

To identify an amount as a refund, click the Event field to see a list of 
available events.  Choose Payment from the list of events. 

The following is an overview of some of the rules applicable to refunds. 

Refund Versus Underpayment Rate 
Starting January 1, 1987 and ending December 31, 1998, the interest rate 
paid on all refunds was reduced to one percentage point lower than the rate 
on underpayments.  For individuals, refund interest is generally included in 
taxable income but interest expense may not be deductible.  As a result, 
taxpayers generally benefit from offsetting overpayments against 
underpayments.  After 1998, the one percent differential was eliminated for 
all taxpayers except C corporations. 

When overpayments and underpayments are included in the same TaxInterest 
problem, the net result is calculated automatically. 

If an underpayment is subject to Motivated tax or “Hot” interest, or if the 
refund is subject to the GATT refund, the rate differential is even greater. 

30-day Rule 
Under §6611(b)(2), the IRS does not have to pay interest on refunds up to the 
date of the refund check.  Instead, the IRS may subtract up to 30 days of 
interest.  The actual number of days subtracted can vary from time to time 
and from one IRS location to another. 

45-day Rule 
Under §6611(e), the IRS has a 45-day period from the later of the due date or 
the date the return is filed to issue a refund without interest.  For example, 
assume an individual files a 2007 refund return on March 1, 2008.  If the IRS 
refunds the tax within 45 days from April 15, 2008, no interest is due.  If the 
refund is paid 46 days after April 15, the taxpayer is entitled to 46 days of 
interest (subject to the 30-day rule described above). 
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With respect to refunds attributable to carryback claims, the 45-day rule 
applies as if the amended return or loss carryback quick refund claim is the 
original return.  As a result, if the IRS issues a refund within 45 days of the 
carryback claim, no interest is paid (See §6611(e)). 

For refund claims other than carryback claims, the IRS is also entitled to a 
45-day interest free period.  The 45-day period only suspends the accrual of 
additional refund interest for the processing period.  As a result, assume a 
taxpayer is entitled to interest on a refund beginning on April 15, 2007.  The 
taxpayer files a refund claim on June 1, 2008 and the IRS pays the refund on 
July 10.  Under the 45-day rule, the IRS will not pay interest with respect to 
the period from June 1 to July 10. 

Refunds for C Corporations  
Beginning January 1999, the refund rate for C corporations is 1% less than 
the refund rate for other taxpayers.  You can identify the taxpayer as a 
corporation by clicking on the C Corp Refund button on the toolbar. 

Starting January 1, 1995, refunds of more than $10,000 to C corporations are 
subject to an additional one and one-half percentage point reduction in the 
refund interest rate.  The higher rate will apply to $10,000 of refund principal 
and all the interest associated with that principal.  This is called the GATT 
refund rule, due to the fact that the legislation was part of the General 
Agreement on Tariffs and Trade. 

Interest Netting 
Surprisingly large interest rate differentials can arise between underpayments 
and overpayments for the taxpayer.  Netting overpayments against 
underpayments between different tax years can help reduce the burden on the 
taxpayer.  Many of these netting calculations are performed by the IRS only 
at the company’s request, with the company bearing the burden of 
establishing whether it is entitled to the interest netting.  

Interest netting is usually performed by tax professionals who specialize in 
making these claims to the IRS for their clients.  Your regular TaxInterest 
software is not designed to handle all the variables required to perform 
comprehensive interest netting.  If you need to perform these calculations, 
contact us about our TaxInterest Netting software.  To learn more about the 
capabilities of TaxInterest Netting, contact us at (800) 426-4741. 
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Calculating Interest and Penalty Totals 
When TaxInterest calculates interest, it uses the information entered on the 
main screen along with the selected interest rate table.  To change the rate 
table used in the calculation, click the Tables button on the toolbar and select 
the appropriate table. 

When TaxInterest calculates penalties, it uses the information entered in the 
active penalty dialogs.  The active penalties for the calculation are shown at 
the bottom of the TaxInterest window next to the heading “Active Penalties.”  
You can click on the listed active penalties to edit the information before 
calculating.  

To calculate interest and penalties 

1. Enter the information for the calculation you are working on.  Activate 
any penalties by clicking the Penalties button on the toolbar. 

2. Click the Compute button on the toolbar or choose Compute Totals 
from the Compute menu.  The Compute Results dialog will appear with 
your results. 

 

Recompute    To change the effective date of your calculation, enter the 
desired date in the Compute date field, and click Recompute.  The 
recalculated results will be displayed. 

Report    To display the details of the calculations on a report, click the 
Report button in the Compute Results dialog.  This is a quick way to display 
the Interest and Penalty Detail Report. 
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Displaying and Printing Reports 
TaxInterest offers an assortment of reports.  These reports can be useful in 
checking the calculations from TaxInterest and for communications with both 
clients and taxing authorities.  The reports display the information used in the 
calculations and the results of the calculations in greater detail. 

To display and print a report 

1. After entering all relevant information on the main screen, click the 
Reports button on the toolbar.  The Report Selection dialog will appear. 

2. Enter the appropriate Compute Date. 

3. Select the report(s) you wish to have displayed on your screen 

4. Click Start to display the selected reports. 

5. To print the displayed report(s), choose Print from the File menu in the 
Reports Window.  You can also save the report as a text file by choosing 
Save As Text File from the File menu in the Reports Window.  A text 
file can be opened by your word processing software. 

To customize a report before printing 

1. After entering all the information on the main screen, click the Print 
button on the toolbar or choose Print from the File menu.  The Report 
Selection dialog will appear. 
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2. Verify or enter the appropriate compute date and select the desired 
report(s) to print. 

3. Select from the options located on the right side of the dialog.  Click OK 
when you are finished. 

The options in the Report Selection dialog are described below. 

Use Description or Event Name? 
You may change the name of a Tax event to a custom name (i.e., “2008 audit 
adjustment”) using the Description fields on the main screen.  To print 
custom names on the report in place of the corresponding event names, select 
Description. 

Include Date or Time? 
This selection allows you to select whether or not to display the date and time 
on reports. 

Include Header or Footer? 
This selection allows you to display a header and footer on reports. Click the 
Edit button to edit the header and footer for the current and future files. 

Creating a header and footer 

To edit the header and footer click the Edit button from the Report Selection 
dialog.  Enter the text you would like for the header and footer and choose 
Use text for this file or Use text for this file and all new files.  Click OK to 
return to the Report Selection dialog. 

Year End for Monthly Accrual 
This option lets you select a fiscal year that will be used in the Monthly 
Accrual detail report. 
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Available Reports 

Interest and Penalty Detail Report 
The Interest and Penalty Detail Report is the primary report used to 
document the interest and penalty calculations.  It consists of three parts and 
each part is also available as an individual report.   

The first part shows a summary of the events, dates, amounts, and 
descriptions from the main screen.  The second part details how interest is 
calculated.  The third part shows how each penalty is computed. 

Payment Allocation Detail Report  
The Payment Allocation Detail Report shows how payments are applied 
among the various event categories. 

Monthly Accrual Report 
The Monthly Accrual Report provides monthly accrual-basis amounts for use 
in financial reporting.  With daily compounding, interest is computed on an 
exact-day basis. Interest for two successive months will be different for the 
following reasons: (1) Interest for the second month is based on an amount 
that includes interest for the first month and (2) the number of days in 
successive months is usually different. 

Interest Detail (with Factors) Report 
The Interest Detail (with Factors) Report shows the interest computations 
included in the Interest and Penalty Detail Report and the factors used to 
reach the interest computations. 

An amount on a given line is calculated by first multiplying the number of 
days by the factor.  This product is then multiplied by the amount from the 
previous line.  The factor is the result of a formula that is used by the IRS in 
calculating daily interest.  The following equation represents this formula. 

                                   Factor 1
Rate

Year Length

days
-1= +

⎛

⎝
⎜

⎞

⎠
⎟  
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Penalty Computation Detail Report 
The Penalty Computation Detail Report shows in detail how each active 
penalty is calculated.  These penalty amounts are also included in the Interest 
and Penalty Detail Report. 

Main Screen Events Report 
The Main Screen Events Report shows a list of the events that appear on the 
main screen. 

Interest Rate Table 
This printout shows the details of a selected interest rate table. 
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Penalty Calculations 
TaxInterest computes a number of federal tax penalties.  The failure to file 
and failure to pay penalties are the most common.  Without TaxInterest, the 
computation of these penalties can be complex.  For example, the failure to 
file penalty of 5% per month is reduced by the failure to pay penalty of 0.5% 
for the period during which both run.   

The following is an example of how to use TaxInterest to automatically 
compute penalties. 

Facts  Flatstone filed and paid his 2006 Form 1040 on the extended due date 
of 10/15/07.  The return was audited in the summer of 2008 which resulted in 
several adjustments to the return.  In total, $15,000 in tax was added to the 
original tax paid on the extension date.  Of the $15,000 tax increase, $3,000 
was determined to be subject to the accuracy related substantial 
understatement penalty.  In addition to the accuracy related penalty, the 
auditor imposed the late payment penalty.  On 06/20/08 a notice of intent to 
levy was given which resulted in an increase of the failure to pay penalty to 
1% per month.  Flatstone wants an interest and penalty calculation as of 
08/15/08. 

Select an interest rate table and enter tax information 

1. Click the Tables button and select Federal.TB3 if the IRS interest rates 
are not selected.  Enter the tax information as shown below. 
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Activate the Failure to Pay Penalty 

2. Click the Penalties button on the toolbar.  Select Failure to pay tax 
shown on return §6651(a)(2).  The Failure to Pay Tax Shown on Return 
dialog will appear. 

3. Click the check box entitled Activate penalty for failure to pay tax 
shown on return if not already selected. 

4. The Tax and Tax due date fields should default correctly for this 
example.  Enter 062008 as the date of the 1st late payment notice.  Select 
Yes to indicate the 1st notice of levy.  Click OK when the Failure to Pay 
dialog appears as shown below. 

 

Activate the accuracy related penalty 

5. In the Penalty Selection Window Select the Substantial understatement 
of income tax §6662(d) penalty.  The Substantial Understatement of 
Income Tax dialog will appear. 

6. Click the check box entitled Activate Substantial Understatement of 
Income Tax (if not already selected). 

7. Enter the extended due date of 101507 as the Due date (with extensions). 

8. The default amount assumes the entire underpayment was attributable to 
the understatement.  In this example, enter 3000 as the amount of the 
underpayment due to the understatement of tax.  Click OK when your 
dialog looks like the example on the following page. 
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 9. Click Close to exit the Penalty Selection Window.   

The bottom of the main screen shows that the failure to pay and 
substantial understatement penalties are active. 

Calculate results 

 10. Click the Compute button on the toolbar to display the Compute Results.  
TaxInterest will use the current date in the window as the interest 
computation date.  For this example, change the compute date to 081508 
and click the Recompute button. 

 
 The Compute Results window should appear as follows: 

  

Solution The total due to the IRS as of August 15, 2008, is $17,788.46. 

To see the detail on the interest and penalty computations, click the Report 
button and the Interest and Penalty Detail Report will be displayed to the 
screen. 
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Refund Interest 
Refund interest is computed like underpayment interest but you must identify 
the amount as a payment in order for TaxInterest to apply special refund 
interest rules.  In addition, refund interest on carrybacks generally starts from 
the due date of the loss or credit year. 

(Note: For periods after 1998, C Corp refunds run at a rate that is 1% lower 
than the rate for individuals.  To identify a taxpayer as a corporation, click on 
the C Corp Refund button on the main screen.) 

Facts  While reviewing his 2004 return, Marty Peters (an individual 
taxpayer) discovers a $10,000 refund due to an overlooked charitable 
contribution.  Peters also wants to carry back a 2005 net operating loss to 
generate an additional $3,000 refund in the 2004 return.  Peters filed his 
refund claim on June 1, 2007, and the refund will be paid on December 1, 
2007.  Gates wants to know the refund amount (including interest) due as of 
December 1, 2007. 

Select an interest rate table and enter first event 

1. Click the Tables button and select Federal.TB3 if the IRS interest rates 
are not selected.  Enter the charitable refund information as shown below. 

 

The first event is entered as a payment in order to calculate the interest 
on the charitable refund.  The description would appear on reports. 
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2. To enter the loss carryback refund on the second event line, choose 
Payment as the event and enter 041506 in the Date field.  (The 
transaction is dated 04-15-06 since the carryback refund begins to accrue 
refund interest on the due date of the return for the loss or credit year). 

3. Enter 3000 as the Amount. 
 
At this point your screen should appear as shown below. 

 

Note that the Description fields were used above to describe each 
Payment. 

Calculate results 

4. Click the Compute button on the toolbar to display the Compute Results.  
For this example, change the compute date to 120107 and click 
Recompute. 

Solution  The total refund due as of December 1, 2007, is $15,548.12.  The 
interest portion of the refund is $2,548.12. 

With respect to refund returns, remember that the 30-day and 45-day interest 
free periods can affect the amount of refund interest.  See a discussion about 
the 30-day and 45-day rules in the TaxInterest Basics section. 

To see the detail on the interest and penalty computations, click the Report 
button and the Interest and Penalty Detail Report will be displayed. 

On your TaxInterest reports, notice that the regular tax and payment events 
reflect the user-defined Descriptions.  If you want to use the Description field 
for notes and you do not want the text to display in reports, choose Report 
Setup from the File menu and select Event name instead of Descriptions. 
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Exam Adjustment for Credit Taken 
TaxInterest allows you to customize the name of tax, payment, and penalty 
events.  You can enter up to 20 characters to identify a transaction.  The 
following is an example of how you can customize names. 

Facts  Roger Santiago and the IRS agreed that a $1,000 credit taken in 2006 
should have been taken in 2007.  Santiago wants to know the amount due as 
of July 1, 2008.  In addition, he wants his Interest and Penalty Detail Report 
to read “06 Exam Adjustment” instead of “Tax” and “06 Credit Allowed” 
instead of “Payment.” 

Select an interest rate table and enter events 

1. Click the Tables button and select Federal.TB3 if the IRS interest rates 
are not selected.  Enter the information as shown below.  

 

Calculate results 

2. Click the Compute button on the toolbar to display the Compute Results.  
For this example, change the Compute Date to 070108 and click 
Recompute. 

Solution    The interest due as of July 1, 2008, is $80.88. 

To see details on the interest and penalty computations, click the Report 
button and the Interest and Penalty Detail Report will be displayed to the 
screen. 
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§6621(c) “Hot” Interest 
Starting in 1991, certain large corporate underpayments became subject to a 
higher rate.  This “Hot” interest rate is applicable to underpayments in excess 
of $100,000 after a specifically defined “applicable” date.  The “Hot” interest 
rate is two full percentage points over the normal rate. 

TaxInterest will automatically compute the “Hot” interest rate but you must 
activate the higher rate and you must identify an applicable date.  Here’s an 
example. 

Facts   Acme Enterprises, a C corporation, is examined by the IRS and is 
found to owe additional tax with respect to its 2006 return.  The IRS sends 
Acme a “30-day letter” on December 12, 2007.  (The “30-day letter” is the 
document that gives Acme an opportunity to meet with an appeals officer.)  
On July 1, 2008, Acme and the IRS settle the case for $200,000 of additional 
tax.  Acme wants to know the total amount due as of July 1, 2008. 

Select an interest rate table and enter initial information 

1. Click the Tables button and select Federal.TB3 if the IRS interest rates 
are not selected.  Enter the tax information as shown below. 

 

Activate Hot Interest 
2. Click the Hot Interest button on the toolbar.  The “Hot” Interest 

Information dialog will appear. 
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3. To activate “Hot” interest, check Activate 6621(c) “Hot” interest 
calculation (if not already selected).   The “Hot” interest dialog allows 
you to choose either a 30-day letter date or the “applicable date.”  In this 
case, enter the 30-day letter date of 121207.  The “Hot” Interest 
Information window will appear as shown below. 

 

4. Click OK to leave this window and return to the main screen. 

Calculate results 

5. Click the Compute button on the toolbar to display the Compute Results.  
Change the compute date to 070108 and click Recompute. 

Solution  The amount due to the IRS as of July 1, 2008, is $255.982.36. 

To see details of the interest and penalty computations, click the Report 
button to display the Interest and Penalty Detail Report.  Notice that on 
January 11, 2008, there is a 6621(c) Hot Interest event that documents the 
starting date for the increased rate. 
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C Corporation Refunds 
Starting in January 1999, the refund rate for C corporations is 1 percent less 
than the refund rate for other taxpayers.  You can identify the taxpayer as a 
corporation by clicking on the C Corp Refund button on the main screen. 

In addition, starting in 1995, C Corp refunds in excess of $10,000 are 
reduced by an additional 1.5 percent.  This rule is known as the GATT refund 
interest rule because it was enacted as part of legislation affecting the General 
Agreement on Tariffs and Trade. 

The General Agreement on Tariffs and Trade (GATT) was passed in the fall 
of 1994. The law included an amendment to section 6621(a)(1) of the 
Internal Revenue Code that provided for a reduced rate of interest on certain 
overpayments of tax by a corporation (hereinafter referred to as "GATT 
interest").  The 1994 GATT amendment materially increased the difficulty of 
computing interest on the overpayments to which it applies. 

As amended, section 6621(a)(1) provides that, to the extent that an 
overpayment of tax by a corporation for any taxable period (as defined by 
section 6621(c)(3)) exceeds $10,000, the interest rate payable on the excess is 
1.5 percentage points below the normal overpayment rate for interest periods 
after December 31, 1994. Thus, for periods after 1994, the interest rate 
differential between the rate payable on normal underpayments and the rate 
payable on overpayments to which the new GATT interest provision applies 
is 2.5 percent (instead of the normal 1 percent) and the interest rate 
differential between the rate payable on "large corporate underpayments" and 
such GATT interest overpayments is 4.5 percent. 
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Facts  On January 1, 2002, Legacy Corporation filed a refund claim for 
$25,000 plus interest for its 2000 tax year.  On July 1, 2002, Legacy 
Corporation received a refund check for only $9,000.  After additional 
discussions with the IRS, the Service agreed to refund the remaining $18,000 
of principal, plus interest.  Legacy Corporation wants to know the refund 
interest as of March 15, 2008. 

Select an interest rate table and enter initial information 

1. Click the Tables button and select Federal.TB3 if the IRS interest rates 
are not already selected.  Enter the information for the initial refund 
claim as shown below.  

 

2. To reflect the 2002 refund check from the IRS, tab to the second event 
line and select IRS Check as the Event. 

3. Enter 070102 as the date and 9000 as the amount.  Your screen will look 
like this. 

 

4. Click the C Corp Refund button in the toolbar and the dialog will 
appear as shown on the following page. 
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5. Check Treat taxpayer as a C Corporation to activate the C Corp 
Refund computation.  The 10,000 threshold amount is applicable, so 
click OK to return to the main screen. 

Calculate results 

6. Click the Compute button on the toolbar to display the results.  For this 
example, change the compute date to 031508 and click Recompute. 

Solution  Refund due as of March 15, 2008, is $21,976.98. 

Click the Report button to display the Interest and Penalty Detail Report.  
You will see that on December 31, 2001, there is a transaction called GATT 
Starts.  From that point on, the interest stream will be divided into a GATT 
Rate portion and a High Rate portion. 
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State Tax Underpayment Calculations 
TaxInterest calculates underpayment and overpayment (refund) interest for 
most states.  The software will also calculate interest on penalties but will not 
calculate actual penalty amounts for non-Federal jurisdictions. 

The following is an example of how you can use TaxInterest to compute 
interest for a state underpayment and penalty situation. 

Note  The state and federal rate tables are updated quarterly (or when 
applicable) for current TaxInterest subscribers.  If you need to calculate 
interest for a jurisdiction outside of the selection of interest rates provided in 
the software, you can create your own rate table.  See page 51 for more 
information.   

Facts   Gil Herrera has a ranch in Texas.  He over capitalized the value of 
his cattle and had to file an amended return for the state of Texas.  The tax 
due for his 2004 return was $8,000.  As there is tax due, there will also be a 
non-interest bearing 5% failure to pay penalty.  Herrera wants to know the 
total remaining amount due to settle on July 31, 2008. 

Although TaxInterest does not perform penalty calculations for states and 
other non-federal jurisdictions, you can use the Entered Penalty event to 
input a penalty.  You may need to research the applicable penalty rules first.  
Penalties input with the Entered Penalty event are interest bearing.  If the 
penalty is non-interest bearing, you can input the penalty on the compute 
date.  In that case, since no time has elapsed, there is no interest calculated. 

Select an interest rate table and enter initial information 

1. Click the Tables button and select TX.TB3 from the list of available rate 
tables.  Click OK to close the rate table dialog.  Enter the tax information 
as shown below. 
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Entered penalty event 
2. Tab to line 2 and select Entered penalty as the event. 

3. Enter 073108 as the date and 400 (5% of the $8000 tax) as the penalty 
amount. 

 You can also enter a description for the Entered penalty event to appear 
on reports. 

 

Calculate results 

4. Click the Compute button on the toolbar to display the Compute Results.  
For this example, change the compute date to 073108 and click 
Recompute. 

Solution  The amount due to the Texas taxing authority as of July 31, 2008, 
is $10,540.28. 

To see details on the interest and penalty computations, click the Report 
button and the Interest and Penalty Detail Report will be displayed.   
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Estimated Tax Penalties 
If you know the amount of a required estimated tax installment on the 
installment due date, you can use TaxInterest to compute and verify 
estimated tax penalties.   

Caution  Even if you think you know the amount of required installments, 
remember that the required installments can be affected by annualization, the 
prior year safe harbor rules, modified tax rules, and other issues.   

§6654 (for individuals) and §6655 (for corporations) provide a penalty if the 
amount of income tax withheld plus estimated tax payments is less than the 
amount of the required installments.  The penalty is computed using simple 
interest on the underpayment.  

To compute an estimated tax penalty, select the 2210 or 2220 interest rate 
table and then enter the amount of the required installments as tax due on the 
installment due dates.  Since the estimated tax penalty stops running on the 
due date of the return and no interest runs on the penalty until the IRS issues 
notice and demand for payment, stop the interest calculation as of the due 
date of the return.  Here’s an example. 

Facts  C.J. Miller failed to make estimated tax payments with respect to his 
2007 individual income tax return.  You have determined that he had 
required installments of $3,000 on April 15, 2007, $3,000 on June 15, 2007, 
$3,000 on September 15, 2007, and $3,000 on January 15, 2008.  Miller 
wants to know the amount due for the estimated tax penalty as of the due date 
of the return. 

Select a rate table and enter estimated tax installments 

1. Click the Tables button and select 2210.TB3 from the list of available 
rate tables.   
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2. Click OK to close the rate table dialog.  Enter the information for the 

four estimated tax installments as shown below.  Each event will be a tax 
event. 

 

Calculate results 

3. Click the Compute button on the toolbar to display the results.  Since the 
estimated tax penalty stops running on the due date of the return, change 
the compute date to 041508 and click Recompute.  The Compute Results 
window will appear as shown on the following page. 
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Solution   The amount of the underpayment penalty as of April 15, 2008, is 
$606.84.  Because the estimated tax penalty is equal to the interest on the 
installment underpayment interest calculation, the penalty amount is reflected 
on the interest line. 

To see details of the interest and penalty computations, click the Report 
button and the Interest and Penalty Detail Report will be displayed. 

Calculating Interest on the 2210 or 2220 penalty  
Interest on the 2210 penalty is not calculated until the IRS sends notice and 
demand to pay the penalty.  To compute interest on the estimated tax penalty, 
you must start a second TaxInterest schedule.  Enter the amount of the 
penalty as an Entered penalty event.  Interest on the penalty runs at the 
Federal rate, not the 2210 or 2220 rates.  As a result, you must select the 
Federal IRS interest table.  The date for the penalty will be the date that the 
penalty begins to accrue interest, that is, the date of notice and demand to pay 
the penalty. 
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FIN 48 Interest and Penalty Calculations 
FIN 48, more formally known as FASB Interpretation No. 48 of FASB 
Statement No. 109, clarifies the accounting for uncertainty in income taxes 
recognized in an enterprise’s financial statements. 

This Interpretation prescribes a recognition threshold and measurement 
attribute for the financial statement recognition and measurement of a tax 
position taken or expected to be taken in a tax return. This Interpretation also 
provides guidance on interest and penalties. 

The commencement of interest accrual should be in accordance with the 
relevant tax law; for example, in the U.S. federal tax system, a calendar-year 
company starts accruing interest on March 15 of the year following the year 
in which the position is being taken on a tax return. 

How TaxInterest Can Help 
TaxInterest is a great tool for your interest calculations for FIN 48.  You can 
do both your federal and state calculations.  If you are using a spreadsheet to 
track your FIN 48 positions, you can easily input the dollar amounts and 
applicable dates into TaxInterest to compute your interest accruals. 

Calculating Interest 

On a single TaxInterest schedule, you can enter all your FIN 48 tax positions 
as Tax events, along with their applicable tax due dates.  When you click the 
Compute button, you can then change the compute date to the date through 
which you wish to accrue interest. 

Note that this method allows you to keep a cumulative schedule for your 
interest accrual. 

Calculating Interest and Penalties 

If you want to include penalty calculations, you will need to create a separate 
TaxInterest schedule for each tax year.  For example, the tax date for a 2004 
position of a calendar year company would be March 15, 2005.  If you need 
to accrue penalties, such as Failure to Pay, click on the Penalties button on 
the toolbar. 

When you click the Compute button, you can then change the compute date 
to the date through which you wish to accrue interest and penalties. 
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TaxInterest stores federal and state interest rates in tables.  TimeValue 
Software keeps the interest rates in your TaxInterest software updated for 
you.  As long as your subscription to TaxInterest is current, you will receive 
quarterly updates on CD or via download. 

Keep your TaxInterest Update Service current to be sure your software 
contains the most current tax rules and interest rates.  If you are not receiving 
quarterly TaxInterest updates, call us at (800)) 426-4741 or email 
support@timevalue.com. 

If you find a need to update or modify the interest rates yourself or create a 
rate table for a jurisdiction not provided by TaxInterest, you can choose Edit 
Interest Rate Table from the Options menu. 

Interest Rates Dialog 
To see the interest rates, choose the Edit Interest Rate Table from the 
Options menu.  The following window will appear: 

 

The fields in the Interest Rates window are described on the following pages. 
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Table Name 
The name that will appear on the main screen and reports. 

Table Description 
Allows up to 20 characters to describe the table.  This description will appear 
on the main screen and reports. 

Table End Date 
Specifies the date through which the rate table is valid. 

Starting Date 
The date the interest rates shown on this line take effect.  A rate remains in 
effect until the next starting date is encountered. 

Computation Mode 
Select the computation method by typing the first character of the following 
methods: 

Daily  Daily compounding has been used by the IRS since January 1, 1983.  
To use daily compounding, type D. 

Simple  Simple interest was used by the IRS from February 1, 1980 through 
December 31, 1982.  To use simple interest, type S. 

Old IRS M/D/Y  The old IRS month/day/year simple method was used 
before February 1, 1980.  To use this method, type O. 

Annual Interest Rates 
TaxInterest allows you to enter three rates for each time period.  The rates are 
described here. 

Normal   The rate that applies to both ordinary tax deficiencies and 
penalties.  To enter a 10% annual rate, type 10 and press Enter.  (The “Hot” 
interest rate for large corporate underpayments is computed automatically.) 

Motivated   The rate applicable to substantial tax-motivated deficiencies.  
Even though the motivated tax rules are repealed, they continue to apply for 
prior years.  The motivated rate is 120% of the ordinary rate. 
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Refund   The overpayment rate applicable to taxpayers other than C 
corporations.  (The C corporation rate is activated by clicking on the C Corp 
Refund button on the main screen.) 

Days Per Year 
Beginning January 1, 1983, the federal daily rate is 1/365 of the annual rate 
in non-leap years and 1/366 of the annual rate in leap years.  State rates vary 
between 365 and 366 day years. 

Interest Rates Dialog Commands 

Browse 

Click on the Browse button to see a list of available tables. 

Save 

Saves the table that is currently loaded. 

New 

To create a new table, click on the New button and a blank table will be 
presented.  Enter the table name, description, end date, starting date, and 
interest rate computation information. 

Delete line 

Deletes the line the cursor is on. 

Sort  

Click on the Sort button to arrange the information in chronological order. 

Close 

Leaves the Interest Rates window and returns you to the main input screen.  
If you have made changes to the current rate table, you will be asked whether 
or not to save the revised table. 
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Updating or Creating a Table 

To manually update an interest rate table 

1. Select Edit Interest Rate Table from the Options menu to display the 
Interest Rates dialog. 

2. Click the Browse button and select the table of rates you wish to update 
and click Open. 

3. On the next available line, enter the new rate information or make 
whatever changes are needed. 

4. When you've finished entering rates, go to the Table End Date field and 
enter the appropriate table end date. 

5. To save your revised table, click on the Save button. 

Creating a new interest rate table 
To create a new interest rate table, you can modify an existing table or start 
with a blank rate template. 

To use an existing rate table as a template for a new table 

1. Follow steps 1 and 2 above. 

2. Modify the information in the table as needed. 

3. Click the Save button and when the Save As dialog appears, enter a name 
for the modified table and click Save.  This will not disturb the 
information in the original table you used as a template. 

To create a new rate table from an empty template 

1. Select Edit Interest Rate Table from the Options menu to display the 
Interest Rates dialog.  

2. Click the New button to display an empty Interest Rates dialog. 

3.  Enter the necessary table information. 

4. To save your new rate table, click the Save button. 
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Introduction to Penalties 
The penalty descriptions on the following pages include the effect of the 
Revenue Reconciliation Act of 1989.  The Act is generally effective for 
returns due (without regard to extensions) after December 31, 1989.       
Here's how the section numbers are related: 

 IRC Code Section 

Name of Penalty After 1989 Before 1990 

Failure to File Return when Due* 6651(a)(1) Same 

Failure to Pay Tax Shown on Return 6651(a)(2) Same 

Failure to Pay Amount Assessed 6651(a)(3) Same 

Estimated Tax Penalty 6654, 6655 Same 

Failure to Make Deposit of Taxes 6656 Same 

Negligence* 6662(c) 6653(a) 

Substantial Understatement of Income Tax* 6662(d) 6661 

Substantial Valuation Misstatement* 6662(e) 6659 

Substantial Overstatement of Pension 
Liabilities*

6662(f) 6659A 

Substantial Estate or Gift Tax Valuation 
Understatement* 

6662(g) 6660 

Fraud* 6663 6653(b) 

Interest on Penalties 
Some penalties are subject to the accrual of interest from the due date of the 
return and some are subject to interest only upon the receipt of notice and 
demand to pay the penalty.  As a general rule, the penalties marked with an 
asterisk begin to accrue interest from the due date of the return (with 
extensions). 

Waiver or Abatement of Penalties 
As a general rule, penalties may be waived upon a showing of reasonable 
cause.   
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Failure to File Return When Due §6651(a)(1) 
The failure to file penalty runs at 5% per month or fraction of month that a 
return is filed after its due date, including extensions of time for filing.  If a 
return due April 15, 2008, is filed May 15, 2008, the return is one month late.  
If the return is filed on May 16, 2008, the return is two months late. 

Penalty base 

The penalty is computed on the tax required to be shown on the return, 
reduced by payments and credits on or before the payment due date. 

Maximum 

The maximum amount of the penalty is 25%.  The penalty is reduced by the 
amount of the failure to pay tax shown §6651(a)(2) penalty in periods when 
both penalties apply. 

For returns due after 1989, if the failure to file is considered fraudulent, the 
penalty rate is 15% per month instead of 5% per month, and the maximum 
penalty is 75% instead of 25%.   

Minimum 

For income tax returns due after 1982 and more than 60 days late, the penalty 
is subject to a minimum amount of $100 or the underpayment of tax, 
whichever is less. 

When interest on the penalty starts 

Interest on this penalty begins on the due date of the return, including any 
extensions and ends on the date the penalty is paid.  See §6601(e)(2)(B). 

For returns due before July 19, 1984, interest on the penalty begins on the 
date the penalty is assessed by the IRS or July 18, 1984, whichever is earlier. 

Historical notes 

For returns due before 1990, the penalty does not apply to the portion of 
underpayment attributable to fraud under §6653(b).   

For penalties assessed before 1987, the failure to file may act to limit the 
failure to pay amount assessed §6651(a)(3) penalty.  
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Failure to Pay Tax Shown on Return §6651(a)(2) 
The failure to pay tax shown on a return penalty runs at 0.5% per month or 
fraction of month until paid, starting from the due date of the return, 
including extensions of time for payment.  Note that an extension of time for 
payment is very rare and is not the same as the extension of time for filing.  
The failure to pay penalty acts to reduce the §6651(a)(1) failure to file 
penalty for periods when both penalties apply.  

Penalty base 

For any month, the penalty is computed on the amount of tax shown on the 
return reduced by payments on or before the beginning of such month and 
by any allowable credits.  If the return is due and filed April 15, 1988, 
showing tax of $1,000 with no payments and $400 is paid June 1, 1988, the 
base will be $1,000 for the first two months and $600 until the next payment.  

Maximum 

The maximum amount of the penalty is 25%.  The rate increases to 1.0% per 
month after notice of intent to levy under §6331. 

Minimum 

None 

When interest on the penalty starts 

Interest is charged from the date of notice and demand to the date of payment 
of the penalty.  A 10-day or 21-day grace period may apply.  See §6601(e).  

Historical notes 

For returns due before January 1, 1990, the penalty does not apply to the 
portion of underpayment attributable to fraud under §6653(b). 

Presumption of reasonable cause for returns on extension 

If the taxpayer obtains a filing extension, the IRS will presume reasonable 
cause for the abatement of the penalty if the amount of tax estimated on the 
extension is paid in full with the extension request and any balance due is (1) 
no more than 10% of the tax shown and (2) is paid with the return. 
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Failure to Pay Amount Assessed §6651(a)(3) 
The §6651(a)(3) failure to pay amount assessed penalty applies to amounts 
assessed by the IRS and then not paid.  This penalty differs from the 
§6651(a)(2) which applies to amounts shown on a return.  The failure to pay 
amount assessed penalty begins when the taxpayer receives a notice to pay 
and then fails to pay.  

The penalty runs at 0.5% of the amount assessed, per month or fraction of 
month, until paid.  The rate increases to 1.0% per month after notice of levy 
under §6331.   

Penalty base 

If an assessment of $1,000 is made on April 8, 2008 and $400 is paid June 1, 
2008, the base will be $1,000 for the first two months (starting April 19, 
since the penalty is imposed based on failure to pay within 10 days of the 
date of notice and demand), then $600 until the next payment. 

Maximum 

The maximum amount of the penalty is 25%. 

Minimum 

None 

When interest on the penalty starts 

Interest is charged from the date of notice and demand to the date of payment 
of the penalty.  A 10-day or 21-day grace period may apply.  See §6601(e).   

Historical notes 

For assessments prior to January 1, 1987, the 25% maximum may be reduced 
by the portion of the failure to file penalty relating to the failure to pay 
amount assessed.   

For returns due before January 1, 1990, the penalty does not apply to the 
portion of underpayment attributable to fraud under §6653(b). 
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Negligence §6662(c) 
For returns due after 1989, the negligence penalty is 20% of the 
underpayment to which §6662 (accuracy-related penalties) applies.  The 
accuracy-related penalties, including negligence, apply only when a return 
has been filed.  For returns due after 1989, any part of the underpayment 
subject to the fraud penalty is not subject to the negligence penalty. 

For returns with due dates before 1990, the penalty is 5% of the total 
underpayment.   

For returns with due dates before 1989 and after 1981, the penalty is 
increased by 50% of underpayment interest for items attributable to 
negligence.  The 50%-of-interest is based on the interest that would be due 
on the portion of the underpayment attributable to negligence.  This interest 
is computed from the due date of the return, without regard to extensions, and 
ends on the date of assessment or payment (if earlier). 

Penalty base 

The penalty is based on the amount of the underpayment attributable to 
negligence.   

When interest on the penalty starts 

As with all of the accuracy-related penalties, interest on the penalty runs from 
the due date of the return (with extensions). 

For returns due before 1989, interest on the penalty is charged from the date 
of notice and demand to the date of payment of the penalty.  A 10-day or 21-
day grace period may apply.  See §6601(e).   

Historical notes 

Prior to Revenue Reconciliation Act of 1989, the negligence penalty was 
found in §6653(a).   
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Substantial Understatement of Income Tax §6662(d) 
For returns due after 1989, the substantial understatement penalty is 
computed at a 20% rate.  

For returns due before 1990 with penalties assessed after October 21, 1986, 
the rate is 25%.  For other returns with due dates after 1982, the rate is 10%.  
(See,  Pallottini v. Commissioner, 90 T.C. 498 (1988) for resolution of the 
confusion regarding when the penalty increased from 10% to 25%.) 

Penalty base 

The penalty is based on the amount of understatement of income tax for a tax 
year.  The penalty applies if the understatement exceeds the greater of 10% of 
the tax required to be shown on the return or $5,000 ($10,000 for 
corporations other than an S corporation or personal holding company). 

Generally, the penalty does not apply to any portion of the underpayment for 
which the taxpayer has substantial authority.  (A higher standard is applied 
with respect to tax shelters.)  The penalty does not apply to any portion of the 
underpayment due to fraud. 

When interest on the penalty starts 

As with all of the accuracy-related penalties, interest on the penalty runs from 
the due date of the return (with extensions).  For penalties assessed before 
July 19, 1984, interest on the penalty starts on the assessment date. 

Historical notes 

Prior to Revenue Reconciliation Act of 1989, the substantial understatement 
penalty was found in §6661.   

For returns due before 1990 the penalty base excludes the portion of 
substantial understatement on which a penalty is imposed under §6659 
relating to addition to tax in the case of valuation overstatements.  
§6661(b)(3). 
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Substantial Valuation Misstatement §6662(e) 
For returns due after 1989, this penalty is applicable to all taxpayers.  Before 
1990 it was limited to individuals, closely held corporations, and personal 
service corporations. 

Here are the penalty rates for returns due after 1989: 
 

 Percentage overstatement  Penalty % 
 Under 200%   None 
 200% or more but under 400% 20% 
 400% or more   40% 
 (No special rate for charitable deduction property) 
 
Here are the penalty rates for returns due before 1990: 
 

 Percentage overstatement  Penalty % 
 Under 150%   None 
 150% or more but under 200% 10% 
 200% or more but under 250% 20% 
 250% or more   30% 

For underpayments attributable to valuation overstatements related 
to charitable deduction property, the rate is 30%. 

Penalty base 

The penalty is based on the amount of underpayment for a taxable year that is 
attributable to a valuation overstatement. 

For returns due after 1989, the penalty applies only if the underpayment 
exceeds $5,000 ($10,000 for a corporation other than an S corporation or a 
personal holding company).  For returns before 1990, the penalty applies 
only if the underpayment is at least $1,000. 

When interest on the penalty starts 

As with all of the accuracy-related penalties, interest on the penalty runs from 
the due date of the return (with extensions). 
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Historical notes 

Prior to the Revenue Reconciliation Act of 1989, the substantial valuation 
misstatement penalty was found in §6659 and was called the substantial 
valuation overstatement penalty. 

For returns due after 1989, there is no stacking of this penalty with other 
accuracy-related penalties under §6662.  The penalty does not apply to any 
portion of underpayment due to fraud. 

For returns due before 1990, underpayments penalized under this section are 
excluded from the penalty base for the §6661 substantial understatement of 
income tax penalty. 
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Substantial Overstatement of Pension Liabilities §6662(f) 
For returns due after 1989, this penalty is applicable to all taxpayers. 

Penalty rates for returns due after 1989: 
 

 Percentage overstatement  Penalty % 
 Under 200%   None 
 200% or more but under 400% 20% 
 400% or more   40% 
 
Penalty rates for returns due before 1990: 
 

 Percentage overstatement  Penalty % 
 Under 150%   None 
 150% or more but under 200% 10% 
 200% or more but under 250% 20% 
 250% or more   30% 

Penalty base 

The penalty is based on the amount of underpayment of tax for a taxable year 
that is attributable to a pension liability overstatement.  For returns due after 
1989, the penalty applies only if the underpayment exceeds $1,000.  For 
returns before 1990, the penalty applies only if the underpayment is at least 
$1,000. 

When interest on the penalty starts 

As with all of the accuracy-related penalties, interest on the penalty runs from 
the due date of the return (with extensions).  For returns due before 1990, 
interest on the penalty is charged from the date of notice and demand to the 
date of payment of the penalty.  A 10-day or 21-day grace period may apply.  
See §6601(e). 

Historical notes 

Prior to Revenue Reconciliation Act of 1989, the valuation overstatement of 
pension liabilities penalty was found in §6659A. 

For returns due after 1989, there is no stacking of this penalty with other 
accuracy-related penalties under §6662.  The penalty does not apply to any 
portion of underpayment due to fraud. 
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Substantial Estate or Gift Tax Valuation Understatement 
§6662(g) 

Penalty rates for returns due after 1989: 
 

 Claimed as % of correct value Penalty % 
 Over 50%   None 
 50% or less but more than 25% 20% 
 25% or less   40%  
 
Penalty rates for returns due before 1990: 
 

 Claimed as % of correct value Penalty % 
 Over 66 2/3%   None 
 66 2/3% or less but at least 50% 10% 
 Under 50% but at least 40%  20% 
 Under 40%   30% 

Penalty base 

The penalty is based on the amount of underpayment for a taxable year that is 
attributable to a valuation understatement. 

For returns due after 1989, the penalty applies only if the underpayment 
exceeds $5,000.  For returns due before 1990, the penalty applies only if the 
underpayment is at least $1,000. 

When interest on the penalty starts 

Interest on the penalty runs from the due date of the return (with extensions). 

Historical notes 

Prior to Revenue Reconciliation Act of 1989, the valuation understatement 
penalty was found in §6660.   

For returns due after 1989, there is no stacking of this penalty with other 
accuracy-related penalties under §6662.  The penalty does not apply to any 
portion of underpayment due to fraud. 
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Fraud  §6663 
For returns due after 1989, this penalty is applicable to all taxpayers.  The 
penalty is 75% of the underpayment due to fraud.  For returns due before 
1987, the rate was 50%, and the penalty applied to the entire underpayment. 

Penalty base 

The 75% (50% for returns due before January 1, 1987) is based on the 
underpayment due to fraud. 

For returns with due dates after September 3, 1982 and before 1989, add 50% 
of the late-payment interest.  The 50%-of-interest penalty is based on the 
interest that would be due on the portion of the underpayment attributable to 
fraud.  The 50%-of-interest penalty is computed from the due date of the 
return to the earlier of the payment date or the assessment date. 

When interest starts 

Interest on the fraud penalty begins on the due date of the return, including 
any extensions and ends on the date the penalty is paid.  See §6601(e). 

For returns due before 1990, interest on the penalty is charged from the date 
of notice and demand to the date of payment of the penalty.  A 10-day or 21-
day grace period may apply.  See §6601(e).   

Historical notes 

Prior to Revenue Reconciliation Act of 1989, the fraud penalty was found in 
§6653(b). 

The accuracy-related penalties (§6662) do not apply to any portion of an 
underpayment on which a penalty is imposed for fraud under §6663. 
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Estimated Tax Penalties §6654 and §6655 
If you know the amount of the required installment on all installment due 
dates, you can use TaxInterest to compute estimated tax penalties.   

Caution  Even if you think you know the amount of required installments, 
remember that they can be affected by annualization, prior year safe harbor 
rules, modified tax rules, and other issues.   

§6654 (for individuals) and §6655 (for corporations) provide a penalty if 
income tax withheld plus estimated tax payments is less than the required 
installments.  It is computed in the same way as interest on an underpayment. 

When you use TaxInterest to compute an estimated tax penalty, select the 
2210 or 2220 interest rate table, and then enter the amount of the required 
installments as tax due on the installment due dates.  The amount of interest 
charged from the installment due dates to the due date of the return is equal 
to the amount of the estimated tax penalty.   

Interest on the penalty does not run until the IRS sends notice and demand to 
pay the penalty.  To compute interest on the estimated tax penalty start a 
second TaxInterest schedule.  Enter the amount of the penalty as an Entered 
Penalty event.  Interest on the penalty runs at the Federal rate, not the 2210 or 
2220 rates.  As a result, you must select the Federal IRS interest table.  The 
date for the penalty will be the date that the penalty begins to accrue interest, 
that is, the date of notice and demand to pay the penalty. 

While most penalties are subject to waiver based upon a showing of 
reasonable cause, §6655(e)(3) sets forth stricter requirements for the 
individual estimated tax penalty.   

The code does not contemplate the waiver of the estimated tax penalty for 
corporations, even upon a showing of reasonable cause. 
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Failure to Deposit §6656 
Most federal tax penalties are based on return due dates.  Some penalties, 
however, such as the failure to deposit penalty and the estimated tax penalty, 
are based on different criteria.   

TaxInterest will not automatically compute the estimated tax or failure to 
deposit penalty, however, TimeValue Software has developed a separate 
program for the failure to deposit penalty.  In addition, this software will 
print the required tax forms on most printers.  For more information on 
Tax941, call TimeValue Software at (800) 426-4741.   

For periods after 1989, the failure to deposit penalty is based on a sliding 
scale.  The penalty percentage is: 

• 2% of underpayment if deposit is made 1 to 5 days late. 

• 5% of underpayment if deposit is made 6 to 15 days late. 

• 10% of underpayment if deposit is more than 15 days late.  

• 15% of underpayment if tax is not deposited on or before the earlier of  
(1) the day 10 days after the date of the first delinquency notice to the 
taxpayer under §6303, or (2) the day on which notice and demand for 
immediate payment is given under §6861 or §6862 or the last sentence of 
§6331(a). 

For periods before 1990, the penalty was 10% of the amount of the 
underpayment and was 5% for penalties imposed before October 22, 1986. 

If you know the amount of the failure to deposit penalty, TaxInterest will 
allow you to include the penalty as part of a TaxInterest calculation.  To 
compute interest on a failure to deposit penalty use the Entered penalty event.  
The date for the Entered penalty event will be the date that the penalty begins 
to accrue interest, that is, the date of notice and demand to pay the penalty.  
The normal 10-day or 21-day grace period may apply. 
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Payment Allocation 
For a variety of reasons, taxpayers may wish to specifically designate the 
application of payments.  For example, the interest amount may be deductible 
or the payment might be used to satisfy a liability that is running interest at a 
higher rate than another item.   

The IRS spells out its position with respect to allocation of payments in Rev. 
Proc. 84-58, and Treas. Reg. §301-6621-2T.  If the taxpayer makes no 
designation, the payment is applied first to tax, then motivated tax, then 
penalties, and finally to interest.  The TaxInterest default payment allocation 
follows the IRS position. 

The IRS default payment allocation rules may not be binding on the taxpayer 
who makes timely designation as to how payments should be applied.   See, 
for example, Perkins v. Commissioner, 92 T.C. 749 (1989), in which the 
court overruled Rev. Proc. 84-58 and allowed the taxpayer to allocate an 
entire payment to interest.   

To see TaxInterest’s allocation, choose Default Payment Allocation from 
the Options menu.  The alphabetic sequence of the letters in the level column 
acts to allocate the payment first to tax, then prorata to penalties. 

When liabilities for multiple years are involved, you must treat each year as a 
separate problem in order to control allocation of payments among individual 
years.  Handling individual years separately may be important in optimizing 
the allocation. 

Caution  Payment allocations that depart from the rules in Rev. Proc. 84-58 
may be challenged by the IRS. 

In order to allocate a payment in TaxInterest, place the cursor in the Amount 
field of a payment event, and choose Allocate a Payment from the Compute 
menu.  The window pictured on the following page will appear. 
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Use the payment allocation window to specify how payments are to be 
applied.  The default in the window above allocates the $1,000 payment 
entirely to tax.  This allocation conforms to IRS default rules. 

You can designate the payment allocation by specific dollar amount or by 
level.  To change by specific dollar amount, type the desired allocation in the 
Specific Dollar Allocation column.  To change the allocation by level, 
change the letter relating to the Tax amount (in this case the letter A) so that 
it follows the letter that relates to the priority of interest amounts (in this case 
the letter D).  If you change the tax designation from A to E, the interest 
designation of D will be paid first. 

To accept any changes you make, click OK to leave the Payment Allocation 
Window.  To cancel your changes, click Cancel. 

The Payment Allocation Window is available whenever a payment amount 
can be used to satisfy a prior liability amount.  If you want the window to 
pop up automatically, choose Payment Allocation Window is Displayed 
from the Options menu. 
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Partial Payments of Tax - Effects on Penalties 
You may occasionally have situations involving both multiple penalties and 
partial payments of tax or motivated tax.  For partial payments of tax, you 
must determine the extent to which a partial payment reduces the portion of 
tax subject to a particular penalty.  What produces the lowest total penalty for 
a particular case depends on the tax year and penalties involved, and the 
taxpayer’s situation.  

TaxInterest first applies partial payments of tax deficiencies to reduce the 
balances subject to the failure to pay amount shown §6651(a)(2) penalty and 
then to the failure to pay amount assessed §6651(a)(3) penalty.  Since the 
negligence penalty can be applied to the same deficiency simultaneously, 
partial payments concurrently reduce the base subject to the negligence 
penalty.  Only when these three bases are eliminated is the base subject to the 
fraud penalty reduced.  The same approach is followed for payments applied 
to tax-motivated deficiencies.  If you want to control this application of 
payments, treat each penalty as a separate problem. 
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Frequently Asked Questions and Answers 
Question 1   How do I compute interest on a refund? 

Answer   To compute interest on a refund, use the Payment event on the 
main screen to represent the refund amount.  Whenever TaxInterest 
determines that there is an overpayment, the program automatically switches 
to the lower refund rate. 

Question 2   How do I start the large corporate underpayment interest rate? 

Answer   Click the Hot Interest button on the toolbar.  When you enter the 
required applicable date information, TaxInterest will automatically compute 
the higher rate. 

Question 3   How do I start the C Corporation refund rate? 

Answer   Click the C Corp Refund button on the toolbar.  When you enter 
the required applicable date information, TaxInterest will automatically 
compute the lower rate. 

Question 4   How do I compute an estimated tax penalty in TaxInterest? 

Answer   TaxInterest can compute the estimated tax penalties only if you 
know the amount of the installment due on the installment due date.  If you 
know the amount of the installment, see the estimated tax penalties example 
in the Examples section. 

Question 5   How do I compute a tax deposit penalty in TaxInterest? 

Answer   TaxInterest cannot compute tax deposit penalties.  The program 
will compute interest on tax deposit penalties if you know the amount of the 
penalty.  To compute a tax deposit penalty amount, use TimeValue 
Software’s Tax941 program. 

Question 4   How do I apply withholdings, estimated tax payments, or 
credits from prior years to a tax? 

Answer   Withholdings, estimated tax payments, and prior year credits are 
applied to a tax on the due date of the return.  
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Edit Menu 
Sort Events    Sorts events in chronological order. 

Delete Line    Deletes the selected event line.  To select a line, click on the 
corresponding line number. 

Compute Menu 
Compute Totals    Computes interest and penalty amounts. 

Penalty Selection    Opens a window that lists the penalties supported 
by the program.  Included are the failure to file, failure to pay, and the 
accuracy-related penalties. 

“Hot” Interest    Opens a window that allows you to activate the 
increased interest rate under IRC section 6621(c). 

C Corp Refund Issues    Opens a window that allows you to identify 
the taxpayer as a corporation, set the amount of the starting GATT threshold, 
and allocate IRS check events against either high rate or GATT rate amounts. 

Allocate a Payment    Opens a window that allows you to allocate the 
application of a payment.  This menu item is only available when the cursor 
is on a line with a payment that may be allocated to a tax. 

Options Menu 
Enter Key Acts as Tab Key    The standard Microsoft Windows 
convention uses the Tab key to move to the next field and the Enter key to 
press the highlighted button.  However, when this menu item is checked, the 
Enter key will move to the next field. 

Show Tips    Many of the penalty windows contain information on how 
TaxInterest uses the information that is entered.  Select Show Tips to display 
these tips. 

Whole Dollar Mode    This setting determines if amounts are entered as 
whole amounts (i.e., no cents).  If this item is checked, all entered amounts 
will be rounded to the nearest dollar.  

Use Event Descriptions on Reports    When checked, this menu 
item automatically uses the information typed in the Description field on the 
main screen in lieu of the normal Event names. 
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Use $100 Minimum in Failure to File    When checked, this menu 
item will automatically apply the $100 minimum failure to file penalty for 
income tax returns that are more than 60 days late.    

Payment Allocation Window is Displayed    When checked, the 
payment allocation window will automatically appear when a payment 
eligible for allocation is entered. 

Default Payment Allocation    Opens a window that lets you change 
default settings on the way payments are applied. 

Default to Show Penalty Status Bar    When checked, the program 
will automatically display active penalties at the bottom of the screen. 

Edit Interest Rate Table    Opens a window that will allow you to edit 
or create interest rate tables. 

 
 
Keyboard Shortcuts 

TaxInterest uses the following keys and key combinations: 

  F1 Calls a help message based on your position in the program. 

 F2 Displays a menu of choices at many points in the program. 

 F3 Brings up penalty selection window. 

 F9 Computes interest and penalties. 

 Alt+? The Alt key plus the first letter of a menu name will open that 
menu. 

Ctrl+D Deletes a line. 

Ctrl+N Starts a new problem. 

Ctrl+O Opens a previously saved file. 

Ctrl+P Displays the print and reports menu. 

Ctrl+S Saves the current TaxInterest problem. 

Ctrl+Z Reverses the previous action. 
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Program Files 

Files Created by the Installation Program 
The TaxInterest installation program will install a number of new files on 
your computer.  Included in the installed files are the following: 

• WTXI.EXE--the TaxInterest program. 

• WTXI.HLP--the TaxInterest help file.  You get help by pressing the F1 
key from wherever you are in TaxInterest. 

• *.TB3--the various federal and state interest rate tables. 

• *.DM--files that create various reports. 

Files You Create With TaxInterest 
When you run TaxInterest, you can save computations, reports, and program 
options.  Here are examples of files created by the program. 

• WTXI.INI --A file that stores the preferences you select in the Options 
menu.  This file is located in your Windows directory. 

• *.TX3--TaxInterest input data.  Created when you save a TaxInterest 
problem. 

• *.TXT--TaxInterest report, in ASCII format.  TaxInterest adds the 
extension .TXT to your file name unless you specify something else. 

• *.TB3--Interest rate table.  You can update existing interest rate tables 
and create new ones. 
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 Interest Rate Rounding 
The interest rates and computations in TaxInterest are handled as double-
precision floating-point values and are accurate to 15 decimal digits.  Tables 
used by taxing authorities may be less precise, often truncating at the eighth 
significant digit. 

Where amounts on which interest is calculated are under $100,000, 
TaxInterest and the IRS should be within a few cents of each other. 

Network Version 
TaxInterest is available in a version that was designed to run on Windows 
networks.  In addition to the regular files created by the program, the network 
version will create files with the extension TXI.  These files contain the user 
specific data. 

TimeValue Software licenses TaxInterest on a per seat basis.  This means that 
each user must pay for a copy of TaxInterest.  Please respect the rights of 
TimeValue Software and refrain from distributing copies of this software.   

Please contact us regarding multiple-user/network or site-license 
arrangements. 
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2210 and penalties 

example  43-45 
penalty basics  65 

2220 and penalties  43, 65 
30-day rule  21 
45-day rule 21-22 
6611(b)(2)  30-day rule, refunds  22 
6611(e)  45-day rule, refunds  22 
6621(c) hot interest 

basic idea  20 
compute menu  73 
example  36–37 

6621(c), Motivated tax  17, 20 
6651(a)(1) Failure to file penalty  55 
 example  8-9 
6651(a)(1), $100-rule  74 
6651(a)(2), Failure to pay tax shown  56 
 example  9, 31 
6651(a)(3), Failure to pay amount assessed  57 
6654 and 6655, Estimated tax penalties  65 
 example  43-45 
6656, Failure to deposit taxes penalty  19, 66 
6662(c), Negligence penalty  58 
6662(d), Understatement of income tax penalty  59 
6662(e), Valuation misstatement penalty  60-61 
6662(f), Overstatement of pension liabilities  62 
6662(g), Estate/gift tax valuation understatemet  63 
6663, Fraud  64 
941 penalties  66 

A 
Abatement of penalties  54 
Accrual report  27 
Address, TimeValue Software  ii 
Allocation of payment report  See Payment allocation 

detail report 
Allocation of payments  See Payments, allocation of 
Annual interest rates  49-50 
ASCII text file  See Exporting a report 

B 
Balance date  See Interest, computation date 

C 
C Corporations 

§6621(c) hot interest, example  36-37, 72, 73 
refunds  22, 38-40, 72, 73 

Calculating 
 interest and penalties  24, 30 
 refund interest  32, 33-34, 40 
 Hot interest  36-37 
 state underpayment interest  41-42 
 estimated tax penalties  43-45 
Carrybacks  22 
Cash bond deposit  16 
Cents mode (setting)  See Whole dollar mode 
Computation date  24 
Computation mode  49 
Compute command (button)  24 
Compute menu 

allocate a payment  73 
C-Corp refund issues  73 
compute totals  73 
GATT refund issues  See Compute menu, C-Corp 

refund issues 
“hot” interest  73 
penalty selection  73 

Copyright notice  ii 
Credits, prior years  72 
Custom tables  51 
Custom events 

event names  18 
example of  6-10, 33-34, 35 

Customizing reports  25-26 

D 
Daily computation mode  49 
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Date and time, on reports  26 
Days per year  50 
Defaults, change  See Options menu 
Deleting a TaxInterest file  12 
Deposit as bond event  16 
Deposit penalty  19, 66, 72 
Descriptions on reports command  26, 74 
Disclaimer  ii 
Displaying reports  25 
Dollars only mode  See whole dollar mode 
 

E 
Enter acts as tab key  73 
Entered penalty  17 
 example  45 
Estate or gift valuation understatement penalty  See 

IRS penalties 
Estimated tax penalties  43-45, 65, 72 
Event summary report  See Main screen events report 
Events 

custom event  18 
deposit as bond  16 
entered penalty  17 
IRS check  17 
IRS penalties  19 
motivated tax  17-18 
payment  16 
refund (payment)  16 
resume interest  17 
suspend interest  17 
tax  16 

Examples 
§6621(c) hot interest  36–37 
C-Corporation refund interest  38-40 
estimated tax penalty  43–45 
exam adjustment for credit taken  35 
FIN 48 interest and penalty calculations  46 
interest and penalties  6-12 
penalty calculations  30-32 
refund interest  33-34 
state tax underpayment calculations  41-42 

Executable file  75 
Exit  12 
Exporting a report  See Text file, exporting to 

F 
Factor  27 
Failure to deposit penalty, §6656  19, 66 
Failure to file penalty, §6651(a)(1) 

$100 minimum  74 
example  8-9 
penalty basics  55 

Failure to pay amount assessed penalty, §6651(a)(3)  
57 

Failure to pay tax shown penalty, §6651(a)(2) 
example  6-10 
penalty basics  56 

Federal rate table  14 
Files 

created by user  75 
program  75 
retrieving  11 
saving  11 

FIN 48 interest and penalties  46 
Fiscal year  See Year end 
Footers  26 
Fraud penalty,  §6663  64 

G 
GATT refunds 

activating  73 
basic idea  22 
command  73 
default  73 
example of  38-40 
IRS check  17 
issues window  40 

 threshold  40, 73 
Grace periods  22 

H 
Headers  26 
Help iii 
Holidays  20 
Hot interest, §6621(c) 

basic idea  20 
command  72 
example of  36-37 

Hot keys  74 
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I 
Include date or time  26 
Include header or footer  26 
Installing TaxInterest  2-3 

on a network  3 
Interest 

calculating  24 
computation date  10 
detail report  See Interest detail (with factors) 
factor  27 
GATT  22 
 example  38-40 
Hot interest  20, 73, 36-37 
overpayments  See Refunds 
penalties 

basic idea  20, 54 
example of  30-32 

rate tables 
basic idea  6, 14, 48 
creating  51 
modifying  51 
selecting  6, 14, 43-44 
updating  15, 48, 51 
dialog  44, 48-50 

refunds  See Refunds 
resume  17 
suspend  17 
underpayments 

§6621(c) Hot interest  20, 36-37 
basic idea  19 

Interest and penalty detail report  27 
Interest detail (with factors) report  27 
Interest netting  21, 22 
Interest rate table report  28 
Interest rates dialog 

commands  50 
fields  48-50 

IRS Check event  17 
IRS penalties 

abatement  54 
activating  8, 9, 19, 31 
before 1990  55 
calculation of  24, 30-32 
deposit penalty  19, 66 
entered penalty  17 
 example  42 
estate or gift tax understatement, §6662(g)  63 

estimated tax, §6654 and §6655  65, 72 
 example 43-45 
failure to deposit  §6656  19, 66, 72 
failure to file, §6651(a)(1)  55 
 example  8-9 
failure to pay amount assessed, §6651(a)(3)  57 
failure to pay tax shown, §6651(a)(2)  56 
 example  6-10 
fraud, §6663  64 
interest on  20-21, 54 
introduction to  19, 54 
multi-year  19 
negligence, §6662(c)  58 
overstatement of pension liabilities, §6662(f)  62 
report  See Interest and penalty detail report 
selection of  73 
understatement of income tax, §6662(d)  59 
valuation misstatement, §6662(e)  60-61 
waiver  54 

K 
Keyboard shortcuts  74 

L 
Large corporations  See C Corporations 
License agreement  ii 

M 
Main screen 

basics  14 
events  16-18 
ID  15 
interest computation date  10, 24 
interest rate table  6, 14, 48 
IRS penalties  19 
name  15 

Main screen events report  28 
Memory requirements  2 
Menus 

compute menu  73 
edit menu  73 
help menu  iii 
options menu  73-74 
reports menu  See Reports 

Monthly accrual report  27 
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Motivated tax, §6621(c) 

basic idea  20 
event  17 

Multiple year penalties  19, 67 

N 
Negligence penalty, §6662(c)  58 
Netting  21, 22 
Network version  3, 76 
New rates  See Interest, rate tables 

O 
Old IRS M/D/Y computation mode  49 
Opening files  11 
Options menu 

default payment allocation  67-68, 74 
default to show penalty status bar  74 
edit interest rate table  74 
enter key acts as tab key  73 
payment allocation window is displayed  74 
show tips  73 
use $100 minimum in failure to file  74 
use event descriptions on reports  74 
whole dollar mode  73 

Overpayment  See Refunds 
Overstatement of pension liabilities  See IRS 

penalties 

P 
Payment allocation detail report  49 
Payment 

allocation of 
basic idea  67-68 
command  67-68, 73 
default  67-68 
report  See Payment allocation detail report 
window  68 

deposit as bond  16 
effects on penalties  69 
event  16, 21 
interest on  20-21 
partial  69 
weekend/holiday rule  20 

Payroll deposit penalties  19, 66 
Penalties  See IRS penalties 

Penalty computation detail report  28 
Penalty selection window  8, 73 
Phone number  (800) 426-4741 or (949) 727-1800 
Preferences  See Options menu 
Prior year credits  72 
Printing 

hot key  74 
reports  11, 25 
report selection dialog  25 
report options  25-26 

Q 
Quitting TaxInterest  12 

R 
Rate tables  See Interest, rate tables 
Recompute  24 
Refund check  See IRS check 
Refund event  See Payment, event 
Refund rate  50 
Refund vs. Underpayment rate  21 
Refunds 

30-day rule  21 
45-day rule  21-22 
C corporations  22, 38-40 
carryback rules  22 
event  See Payment, event 
example of  33-34, 38-40 
GATT interest  22, 38-40 
interest on  21-22, 33-34, 38-40, 72 
IRS check  17 

Report selection dialog  25 
Reports 

customizing  25-26 
displaying to screen  25 
exporting  See Text file, exporting to 
interest and penalty detail  27 
interest detail (with factors)  27 
interest rate table  28 
main screen events  28 
monthly accrual  27 
options  25-26 
payment allocation detail  27 
penalty computation detail  28 

 text file  25 
Resume interest event  17 
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Retrieving files  11 
Rev. Proc. 84-58  16, 67 
Revenue Reconciliation Act of 1989  54 
Rounding  76 

S 
Saturday, Sunday, holiday rule  20 
Saving files  11 
Show tips command  73 
Simple computation mode  49 
Starting date  49 
Starting TaxInterest  6 
Substantial estate or gift valuation understatement 

penalty,  §6662(g)  63 
Substantial overstatement of pension liabilities 

penalty, §6662(f)  62 
Substantial understatement of income tax penalty, 

§6662(d)  59 
Substantial valuation misstatement penalty, §6662(e)  

60-61 
Suspend interest event  17 
System requirements  2 

T 
Table  See Interest rates dialog 
Table of contents  v-vii 
Table description  49 
Table name  49 
Table end date  49 
Tax event  16 
Tax motivated interest  See Motivated tax 
Tax shelter interest  See Motivated tax 
TaxInterest events  16-18  See also Events 
TaxInterest files  75 
TaxInterest Netting  21 
TaxInterest tour  5-12 
Technical support  See Support and Maintenance 
Text file, exporting to  25 
TimeValue Software products  82 

U 
Underpayments  19 
Updating interest rates  15, 48, 51 
Ue description or event name  26 
User-defined events  See Custom events 

W 
Waiver of penalties  54 
Web address  www.timevalue.com 
Weekends  20 
What-if calculations  See Recompute 
Whole dollar mode  73 

Y 
Year end  26 



Products From TimeValue Software 
 

Solutions for 
Financial Professionals 

 
 

TValueTM 
The standard for interest 

calculations and amortization 
TValue is the unrivaled leader for solving 
any time-value-of-money calculation.  Since 
1984, TValue has been paving the way for 
interest calculations that financial 
professionals depend on daily.  Over 
500,000 users rely on TValue for accuracy, 
flexibility, and ease-of-use.  Regardless of 
the complexity of your calculations, TValue 
is the trusted solution. 
 

TValue EngineTM 

Incorporate the accuracy of TValue 
into your custom applications 

The TValue Engine lets you incorporate the 
functionality of TValue into your in-house 
applications.  The TValue Engine is an 
ActiveX (COM) DLL that can be called 
from virtually any Windows based 
programming language. 
 
TCalcTM - Financial Calculators 

Enhance your website 
TCalc - Financial Calculators are easy to 
use web-based calculators that will instantly 
enhance the value of your website.  TCalc 
offers a full selection of financial 
calculators to handle many of your clients 
financial questions. 
 
 
 
 
 
 

Solutions for 
Tax Professionals 

 

TaxInterestTM 
Calculate IRS interest and penalties 

Easily verify the numbers on interest and 
penalty notices from the IRS.  No more 
guessing whether the numbers look right.  
Don’t let you clients pay for IRS mistakes.  
Interest rates and penalty rules are built in.  
Also calculates state interest. 
 

PayrollPenaltyTM 
Cut payroll tax deposit penalties 

Reduce your client’s Failure to Deposit 
penalties by 20%, 30%, even 50%!  
PayrollPenalty uses taxpayer relief 
provisions in the tax code to calculate the 
lowest FTD penalty.  Everything the IRS 
needs to abate the penalty is provided. 
 

Tax941TM 
Verify IRS FTD penalties and  

print error-free payroll tax forms 
Easily calculate Failure to Pay, Failure to 
File, and Failure to Deposit penalties and 
interest.  Print error-free 940, 941, 943, 944, 
and 945 forms for filing. 
 

File In TimeTM 
Track due dates and manage tasks 

Regain control of task management and 
deadline tracking in your office.  This easy 
to use program shows you upcoming due 
dates and tracks progress on each task.  
Print reports that meet your needs. 
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